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1 Introduction

Welcome to PFS Plus, the easiest and most flexible software program available for creating personal
financial statements. PFS Plus is created, maintained, and supported by Pro-Ware, LLC.

1.1 What is PFS Plus?

PFS (or, Personal Financial Statements) Plus is a great tool to aid you in preparing personal financial
statements. Just enter your financial data in the pre-defined categories and PFS Plus will create
professional financial statements that can be printed, emailed, or saved to disk and submitted to a bank
or other financial institution. Once you enter your data in PFS Plus, your work is done. Updating the
data is a snap, so you can modify any of your personal financial data when your financial position
changes.

1.2 Installing PFS Plus

If you are installing PFS Plus for the first time or on another computer, simply follow the on-screen
instructions in the Setup Wizard that appears when you double-click on the Setup file. Should you need
to download the installation for PFS Plus, got to the Pro-Ware website:  http:\\www.proware-cpa.com
and click the downloads option on the menu to download the latest demo version of PFS Plus. Entering
your Activation data will convert the demo version of PFS Plus to an unrestricted version of the program.

1.3 Starting PFS Plus For The First Time

If you have just installed PFS Plus for the first time, the Setup Wizard will prompt you to start the
program automatically after the installation is complete. You can leave the box checked to automatically
start PFS Plus, or start it by clicking the icon that appears on your desktop after the installation is
complete.

1.4 Password Encryption

Since you will be entering confidential data in PFS Plus, it is recommended that you create a password
to password-protect and encrypt your personal data. To enable password protection, click that option
located in the File menu. Once you select this option, you will be required to enter your password twice
for confirmation. Take care to create a password that you will remember because you will not be able to
retrieve the data you have entered in PFS Plus should you forget your password.

1.5 Technical Support

Technical support is included free with your purchase of PFS Plus. Should you need assistance, you
can contact Pro-Ware. LLC using any of the following methods:

 
Voice (402) 861-8800 - Support hours are 8:30 am - 5:00 pm, CST

Fax (402) 861-8653 - 24 hours a day

Internet Web Site - www.proware-cpa.com or www.assetkeeper.com

Email Address - support@proware-cpa.com

 
When calling for technical support, please have your serial number and the version of PFS Plus that you
are using. Your serial number and version number can be found by selecting the About PFS Plus option
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located under the Help menu.
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2 Applicant Information

This is the starting point for data entry in PFS Plus. From this screen, you can enter your name,
address, email address, phone, and other contact information. If you have a co-applicant, you can click
the tab for Co-Applicant data to enter contact information for the co-applicant. In addition, you can enter
Employment History, Financial Advisor Information, and details for the Entity that will receive the
financial statements. Any of the applicant information can be entered or modified at a later time, if
necessary.

2.1 Overview

Once you have entered your Applicant Information, it will be displayed on the Overview tab.

2.2 Applicant Details

Select this tab to enter any of the following information:

Name

Date of Birth

Social Security or Tax ID Number

License or Other Identification Number

Address, City State and Zip Code

Email Address

Daytime, Evening, and Mobile Phone Numbers

Fax Number

Tax Rate

Once finished, your data will be automatically saved.

2.3 Co-Applicant Details

Select this tab to enter any of the following information for you co-applicant:

Name

Date of Birth

Social Security or Tax ID Number

License or Other Identification Number

Address, City State and Zip Code (Click the checkbox to use the same information for the

address that you entered for the applicant)

Email Address

Daytime, Evening, and Mobile Phone Numbers

Fax Number
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Once finished, your data will be automatically saved.

2.4 Employment

This tab allows you to enter employment information. To add an employer, click the "+" button in the
lower left of the window.

Enter any of the following employment information:

Employee (Specifies whether this employment information pertains to the applicant or the

co-applicant)

Start and End Dates of Employment

Position

Employer Name

Contact Name

Address, City, State, Zip Code

Phone and Fax

Email Address

Employer's Website

Click "Save" to save the information when finished.

To delete an entry made to your employment data, highlight the entry and click the "-" (minus) button in
the lower left.

To edit an entry, highlight the entry, click the cogwheel in the lower left of the window and select Edit...
from the drop-down list.

There is also a "Duplicate" option on the drop-down list that will duplicate the previous employer
information entered. From there, you can modify the data as needed for the employment information.

2.5 Advisors

This tab allows you to enter financial advisor information. To add an advisor, click the "+" button in the
lower left of the window.

Enter any of the following information:

Advisor Of (Specifies whether this advisor information pertains to the applicant or the co-

applicant)

Advisement Role

Advisor Name

Company Name
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Address, City, State, Zip Code

Phone and Fax

Email Address

Advisor's Website

Click "Save" to save the information when finished.

To delete an entry made for your financial advisors, highlight the entry and click the "-" (minus) button in
the lower left.

To edit an entry, highlight the entry, click the cogwheel in the lower left of the window and select Edit...
from the drop-down list.

There is also a "Duplicate" option on the drop-down list that will duplicate the previous advisor
information entered. From there, you can modify the data as needed for the advisor information.

2.6 Prepared For

This tab allows you to enter information pertaining to the institution that this data is being prepared for.
To add an institution, click the "+" button in the lower left of the window.

Enter any of the following information:

Institution Name

Contact Name

Address, City, State, Zip Code

Phone and Fax

Email Address

Institution's Website

Click "Save" to save the information when finished.

To delete an entry made to your "Prepared For" data, highlight the entry and click the "-" (minus) button
in the lower left.

To edit an entry, highlight the entry, click the cogwheel in the lower left of the window and select Edit...
from the drop-down list.

There is also a "Duplicate" option on the drop-down list that will duplicate the previous information
entered. From there, you can modify the data as needed.
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3 Assets

Click Assets on the toolbar to enter asset information for you and your co-applicant. When you click the
Assets button for the first time, you will see a blank window where you can add any assets. To start,
click the "+" at the bottom-left of the window.

The following types of assets can be entered in PFS Plus:

Cash

Receivables

Marketable Securities

Partnership Interests

Cash Value of Life Insurance Policies

Retirement Accounts

Vehicles

Personal Property

Primary Residence

Other Real Property

Other Assets

3.1 Adding Assets

To add an asset, click the "+" sign in the lower-left of the window.

3.1.1 General Information

First, select the Asset Type that you are entering data for. Select from among the following asset types:

Cash

Receivables

Marketable Securities

Partnership Interests

Cash Value of Life Insurance Policies

Retirement Accounts

Vehicles

Personal Property

Primary Residence

Other Real Property

Other Assets
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After selecting the asset type, enter the description, cost, valuation method, fair market value, and
valuation date.

3.1.2 Tax Information

Enter any tax information for the asset here.

3.1.3 Notes

Enter any additional notes for your asset here.

3.1.4 Related Liabilities

You can link any related liabilities for the asset on this screen. To link the asset, click the "+" sign on
the lower-left of the window. A popup list of Liabilities will appear from which you can choose to link the
asset to.

3.2 Deleting Assets

To delete an asset that was entered previously, click the minus button in the lower left of the window. A
confirmation screen will appear that indicates that you cannot recover the asset once it is deleted. Click
"Delete" to permanently remove the asset from your file.

3.3 Editing Assets

To edit an asset, click the cogwheel at the bottom left of the window and click "Edit..." The Asset
Details screen appears where you can change any of the existing information previously entered for the
asset. Click "Save" to save your changes or "Cancel" to quit without saving. 

3.4 Duplicating Assets

From the Asset Listing screen, you can highlight any asset and duplicate the information if you have
similar assets. With the asset highlighted on the screen, click the cogwheel on the lower-left of the
window and then click "Duplicate". This will create a new asset with the same information as the
highlighted asset that was previously entered. You will see a duplicated asset with the additional word
(Copy) listed on the screen. From there you can change any of the information by double-clicking the
asset, editing any of the fields and then clicking "Save" to save your changes. Click "Cancel" to close
the screen without applying the changes.

3.5 Deleting All Assets

Choose this option by clicking the cogwheel at the lower-left of the window and selecting the "Delete All
Assets" option. Be careful in using this option because it will delete all of the assets in the file. A
confirmation screen will appear asking you if this is really what you want to do. Click "Delete All" to
confirm the deletion or "Cancel" to cancel the deletion.

3.6 Sorting Assets

The default sorting option for the assets in your file is to sort by liquidity. Assets that are more liquid,
such as cash and marketable securities will appear before assets such as real property or cash value of
life insurance policies. This is the default setting in PFS Plus but can be changed if you like. You can
customize the sorting by selecting that option from the cogwheel menu. When you select this option, a
"Customize List Order" screen appears where you can move assets up or down according to how you
want them sorted. Use the arrows at the bottom left of the window to move assets up or down depending
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on your preference. Click the "Close" button to return to the Asset Listing screen.

3.7 Printing Assets

You can elect to print just one asset by highlighting the asset on the Asset Listing screen and then
selecting the option "Print Selected Asset..." from the cogwheel menu in the lower left of the screen.
You can also print all of the assets by selecting the "Print Asset Listing..." option. When you select the
printing options, a screen will appear that will let you customize your report. You can change the sorting,
which assets to include, the format of the report, the layout, and many other aspects of the report that
will be printed. Click the "Preview" button to preview the report on-screen or "Print" to print the report
without previewing it.

In addition, you can also choose to save the report to disk as a .pdf file. This can be handy if you are
emailing the report or need to view it on a computer that does not have PFS Plus installed. You can
select the name of the file and the location on your computer where you want it saved.
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4 Liabilities

Click Liabilities on the toolbar to enter liability information for you and your co-applicant. When you click
the Liabilities button for the first time, you will see a blank window where you can add any liabilities. To
start, click the "+" at the bottom-left of the window.

The following types of liabilities can be entered in PFS Plus:

Notes/Loans Payable

Income Taxes

Mortgages Payable

Contingent Liabilities

Other Liabilities

4.1 Adding Liabilities

To add a liability, click the "+" sign in the lower-left of the window.

4.1.1 General Information

First, select the Liability Type that you are entering data for. Select from among the following liability
types:

Notes/Loans Payable

Income Taxes

Mortgages Payable

Contingent Liabilities

Other Liabilities

After selecting the liability type, enter the description, amount, payoff amount, interest rate, remaining
payments, and monthly payment.

4.1.2 Notes

Enter any additional notes for your liability here.

4.1.3 Related Assets

You can link any related assets for the liability on this screen. To link the liability, click the "+" sign on
the lower-left of the window. A popup list of Assets will appear from which you can choose to link the
liability to.

4.2 Deleting Liabilities

To delete a liability that was entered previously, click the minus button in the lower left of the window. A
confirmation screen will appear that indicates that you cannot recover the liability once it is deleted.
Click "Delete" to permanently remove the liability from your file.
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4.3 Editing Liabilities

To edit a liability, click the cogwheel at the bottom left of the window and click "Edit..." The Liability
Details screen appears where you can change any of the existing information previously entered for the
liability. Click "Save" to save your changes or "Cancel" to quit without saving. 

4.4 Duplicating Liabilities

From the Liability Listing screen, you can highlight any liability and duplicate the information if you have
similar liabilities. With the liability highlighted on the screen, click the cogwheel on the lower-left of the
window and then click "Duplicate". This will create a new liability with the same information as the
highlighted liability that was previously entered. You will see a duplicated liability with the additional word
(Copy) listed on the screen. From there you can change any of the information by double-clicking the
liability, editing any of the fields and then clicking "Save" to save your changes. Click "Cancel" to close
the screen without applying the changes.

4.5 Deleting All Liabilities

Choose this option by clicking the cogwheel at the lower-left of the window and selecting the "Delete All
Liabilities" option. Be careful in using this option because it will delete all of the liabilities in the file. A
confirmation screen will appear asking you if this is really what you want to do. Click "Delete All" to
confirm the deletion or "Cancel" to cancel the deletion.

4.6 Sorting Liabilities

The default sorting option for the liabilities in your file is to sort by liquidity. Liabilities that are more
liquid, such as loans payable will appear before liabilities such as a contingent liability. This is the
default setting in PFS Plus but can be changed if you like. You can customize the sorting by selecting
that option from the cogwheel menu. When you select this option, a "Customize List Order" screen
appears where you can move liabilities up or down according to how you want them sorted. Use the
arrows at the bottom left of the window to move liabilities up or down depending on your preference. Click
the "Close" button to return to the Liability Listing screen.

4.7 Printing Liabilities

You can elect to print just one liability by highlighting the liability on the Liability Listing screen and then
selecting the option "Print Selected Liability..." from the cogwheel menu in the lower left of the screen.
You can also print all of the liabilities by selecting the "Print Liability Listing..." option. When you select
the printing options, a screen will appear that will let you customize your report. You can change the
sorting, which liabilities to include, the format of the report, the layout, and many other aspects of the
report that will be printed. Click the "Preview" button to preview the report on-screen or "Print" to print the
report without previewing it.

In addition, you can also choose to save the report to disk as a .pdf file. This can be handy if you are
emailing the report or need to view it on a computer that does not have PFS Plus installed. You can
select the name of the file and the location on your computer where you want it saved.
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5 Revenues

Click Revenues on the toolbar to enter revenue information for you and your co-applicant. When you
click the Revenues button for the first time, you will see a blank window where you can add any
revenues. To start, click the "+" at the bottom-left of the window.

The following types of revenues can be entered in PFS Plus:

Salaries/Wages

Bonuses/Commissions

Dividends

Interest Income

Rental Income

Royalties

Child Support Received

Alimony Received

Retirement Benefits

Partnership Distributions

Other Income

5.1 Adding Revenues

To add a revenue or income item, click the "+" sign in the lower-left of the window.

5.1.1 General Information

First, select the Revenue Type that you are entering data for. Select from among the following revenue
types:

Salaries/Wages

Bonuses/Commissions

Dividends

Interest Income

Rental Income

Royalties

Child Support Received

Alimony Received

Retirement Benefits

Partnership Distributions

Other Income
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After selecting the revenue type, enter the description, amount, and frequency of the revenue stream.

5.1.2 Notes

Enter any additional notes for the revenue here.

5.2 Deleting Revenues

To delete a revenue amount that was entered previously, click the minus button in the lower left of the
window. A confirmation screen will appear that indicates that you cannot recover the revenue item once
it is deleted. Click "Delete" to permanently remove the revenue amount from your file.

5.3 Editing Revenues

To edit a revenue amount, click the cogwheel at the bottom left of the window and click "Edit..." The
Revenue Details screen appears where you can change any of the existing information previously
entered for the revenue item. Click "Save" to save your changes or "Cancel" to quit without saving. 

5.4 Duplicating Revenues

From the Revenue Listing screen, you can highlight any revenue item and duplicate the information if you
have similar revenue streams. With the revenue item highlighted on the screen, click the cogwheel on
the lower-left of the window and then click "Duplicate". This will create a new revenue amount with the
same information as the highlighted revenue item that was previously entered. You will see a duplicated
revenue amount with the additional word (Copy) listed on the screen. From there you can change any of
the information by double-clicking the revenue item, editing any of the fields and then clicking "Save" to
save your changes. Click "Cancel" to close the screen without applying the changes.

5.5 Deleting All Revenues

Choose this option by clicking the cogwheel at the lower-left of the window and selecting the "Delete All
Revenues" option. Be careful in using this option because it will delete all of the revenue amounts in the
file. A confirmation screen will appear asking you if this is really what you want to do. Click "Delete All"
to confirm the deletion or "Cancel" to cancel the deletion.

5.6 Sorting Revenues

The default sorting option for the revenues in your file is shown on the drop-down list. The default sorting
for revenues in PFS Plus can be changed if you like. You can customize the sorting by selecting that
option from the cogwheel menu. When you select this option, a "Customize List Order" screen appears
where you can move revenue items up or down according to how you want them sorted. Use the arrows
at the bottom left of the window to move revenue amounts up or down depending on your preference.
Click the "Close" button to return to the Revenue Listing screen.

5.7 Printing Revenues

You can elect to print just one revenue item by highlighting it on the Revenue Listing screen and then
selecting the option "Print Selected Revenue..." from the cogwheel menu in the lower left of the screen.
You can also print all of the revenue items by selecting the "Print Revenue Listing..." option. When you
select the printing options, a screen will appear that will let you customize your report. You can change
the sorting, which revenue amounts to include, the format of the report, the layout, and many other



PFS Plus Help26

© 2011 Pro-Ware, LLC

aspects of the report that will be printed. Click the "Preview" button to preview the report on-screen or
"Print" to print the report without previewing it.

In addition, you can also choose to save the report to disk as a .pdf file. This can be handy if you are
emailing the report or need to view it on a computer that does not have PFS Plus installed. You can
select the name of the file and the location on your computer where you want it saved.
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6 Expenses

Click Expenses on the toolbar to enter expense information for you and your co-applicant. When you
click the Expenses button for the first time, you will see a blank window where you can add any
expenses. To start, click the "+" at the bottom-left of the window.

The following types of expenses can be entered in PFS Plus:

Installment Payments

Mortgage Payments

Rental Payments

Child Support Payments

Alimony Payments

Insurance Payments

Household Expenses

Medical/Dental Expenses

Other Expenses

6.1 Adding Expenses

To add an expense, click the "+" sign in the lower-left of the window.

6.1.1 General Information

First, select the Expense Type that you are entering data for. Select from among the following expense
types:

Installment Payments

Mortgage Payments

Rental Payments

Child Support Payments

Alimony Payments

Insurance Payments

Household Expenses

Medical/Dental Expenses

Other Expenses

After selecting the expense type, enter the description, amount, and frequency of the expense amount.

6.1.2 Notes

Enter any additional notes for the expense item here.
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6.2 Deleting Expenses

To delete an expense amount that was entered previously, click the minus button in the lower left of the
window. A confirmation screen will appear that indicates that you cannot recover the expense item once
it is deleted. Click "Delete" to permanently remove the expense amount from your file.

6.3 Editing Expenses

To edit an expense amount, click the cogwheel at the bottom left of the window and click "Edit..." The
Expense Details screen appears where you can change any of the existing information previously
entered for the expense item. Click "Save" to save your changes or "Cancel" to quit without saving. 

6.4 Duplicating Expenses

From the Expense Listing screen, you can highlight any expense item and duplicate the information if
you have similar expenses. With the expense item highlighted on the screen, click the cogwheel on the
lower-left of the window and then click "Duplicate". This will create a new expense amount with the same
information as the highlighted expense item that was previously entered. You will see a duplicated
expense amount with the additional word (Copy) listed on the screen. From there you can change any of
the information by double-clicking the expense item, editing any of the fields and then clicking "Save" to
save your changes. Click "Cancel" to close the screen without applying the changes.

6.5 Deleting All Expenses

Choose this option by clicking the cogwheel at the lower-left of the window and selecting the "Delete All
Expenses" option. Be careful in using this option because it will delete all of the expense amounts in the
file. A confirmation screen will appear asking you if this is really what you want to do. Click "Delete All"
to confirm the deletion or "Cancel" to cancel the deletion.

6.6 Sorting Expenses

The default sorting option for the expenses in your file is shown on the drop-down list. The default sorting
for expenses in PFS Plus can be changed if you like. You can customize the sorting by selecting that
option from the cogwheel menu. When you select this option, a "Customize List Order" screen appears
where you can move expense items up or down according to how you want them sorted. Use the arrows
at the bottom left of the window to move expense amounts up or down depending on your preference.
Click the "Close" button to return to the Expense Listing screen.

6.7 Printing Expenses

You can elect to print just one expense item by highlighting it on the Expense Listing screen and then
selecting the option "Print Selected Expense..." from the cogwheel menu in the lower left of the screen.
You can also print all of the expense items by selecting the "Print Expense Listing..." option. When you
select the printing options, a screen will appear that will let you customize your report. You can change
the sorting, which expense amounts to include, the format of the report, the layout, and many other
aspects of the report that will be printed. Click the "Preview" button to preview the report on-screen or
"Print" to print the report without previewing it.

In addition, you can also choose to save the report to disk as a .pdf file. This can be handy if you are
emailing the report or need to view it on a computer that does not have PFS Plus installed. You can
select the name of the file and the location on your computer where you want it saved.
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7 Reports

This option located in the toolbar will display a list of the reports you can print in PFS Plus. The following
reports are available:

Financial Statements

Asset Listing

Liability Listing

Revenue Listing

Expense Listing

Applicant Information

7.1 Financial Statements

You can print complete personal financial statements by selecting the "Financial Statement" option from
the Reports button on the toolbar. When you select the "Financial Statements" option, a screen will
appear that will let you customize the reports that will be printed. You can change the following items for
your printed financial statement:

Applicant Name - You can change the name of the applicant, if necessary.

Document Title - Change the title for this statement, if necessary.

Prepared For - You can select the "Prepared For" item among the list provided or add a

new item by clicking the "+" sign next to the drop-down list.

Pages to Print - Select the pages of the report you would like to print.

Signature Lines - Select the number of lines and what pages to print them on.

Layout - Choose left or center alignment for the report.

Header/Footer Options - Select the page number to start printing, whether to print the date

in the header or footer, and what pages to print the footer on.

You can also choose to restore the default settings for the financial statements by clicking the "Restore
Defaults" button.

Once you have selected the settings for your report, you can click the "Preview" button to preview the
report on-screen or "Print" to print the report without previewing it.

In addition, you can also choose to save the report to disk as a .pdf file. This can be handy if you are
emailing the report or need to view it on a computer that does not have PFS Plus installed. You can
select the name of the file and the location on your computer where you want it saved.

7.2 Asset Listing

You can print any or all of the Assets by selecting the "Asset Listing" option from the Reports button on
the toolbar. When you select the "Asset Listing" report, a screen will appear that will let you customize
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the report. You can change the sorting, which assets to include, the format of the report, the layout, and
many other aspects of the report that will be printed. Click the "Preview" button to preview the report on-
screen or "Print" to print the report without previewing it.

In addition, you can also choose to save the report to disk as a .pdf file. This can be handy if you are
emailing the report or need to view it on a computer that does not have PFS Plus installed. You can
select the name of the file and the location on your computer where you want it saved.

7.3 Liability Listing

You can print any or all of the Liabilities by selecting the "Liability Listing" from the Reports button on
the toolbar. When you select the "Liability Listing", a screen will appear that will let you customize your
report. You can change the sorting, which liabilities to include, the format of the report, the layout, and
many other aspects of the report that will be printed. Click the "Preview" button to preview the report on-
screen or "Print" to print the report without previewing it.

In addition, you can also choose to save the report to disk as a .pdf file. This can be handy if you are
emailing the report or need to view it on a computer that does not have PFS Plus installed. You can
select the name of the file and the location on your computer where you want it saved.

7.4 Revenue Listing

You can print any or all of the Revenue items by selecting the "Revenue Listing" from the Reports button
on the toolbar. When you select the "Revenue Listing" report to print, a screen will appear that will let
you customize your report. You can change the sorting, which revenue amounts to include, the format of
the report, the layout, and many other aspects of the report that will be printed. Click the "Preview"
button to preview the report on-screen or "Print" to print the report without previewing it.

In addition, you can also choose to save the report to disk as a .pdf file. This can be handy if you are
emailing the report or need to view it on a computer that does not have PFS Plus installed. You can
select the name of the file and the location on your computer where you want it saved.

7.5 Expense Listing

You can print any or all of the Expense items by selecting the "Expense Listing" from the Reports
button from the toolbar. When you select the "Expense Listing" report, a screen will appear that will let
you customize your report. You can change the sorting, which expense amounts to include, the format
of the report, the layout, and many other aspects of the report that will be printed. Click the "Preview"
button to preview the report on-screen or "Print" to print the report without previewing it.

In addition, you can also choose to save the report to disk as a .pdf file. This can be handy if you are
emailing the report or need to view it on a computer that does not have PFS Plus installed. You can
select the name of the file and the location on your computer where you want it saved.

7.6 Applicant Information

You can print the Applicant and Co-Applicant information by selecting the "Applicant Information" option
from the Reports button on the toolbar. When you select the "Applicant Information" report, a screen will
appear that will let you customize the report. You can change many of the options for the report
including which information to include. In addition, you can change the format of the report, the layout,
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and many other aspects of the report that will be printed. Click the "Preview" button to preview the report
on-screen or "Print" to print the report without previewing it.

In addition, you can also choose to save the report to disk as a .pdf file. This can be handy if you are
emailing the report or need to view it on a computer that does not have PFS Plus installed. You can
select the name of the file and the location on your computer where you want it saved.
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8 PFS Plus Options

You can change your preferences for PFS Plus by selecting the "Options..." item located at the bottom
of the "Edit" menu.

By selecting the "Options..." you can change the following:

General Options - Select whether you want the PFS Plus splash screen to display when

starting the program.

Folder Options - Change the location of your data folder.

Message Options - Restore any messages previously displayed that have a "Do not show

again" option.

Update Options - Change the frequency of how often PFS Plus checks for updates.

8.1 Options

You can change your preferences for PFS Plus by selecting the "Options..." item located at the bottom
of the "Edit" menu.

By selecting the "Options..." you can change the following:

General Options - Select whether you want the PFS Plus splash screen to display when

starting the program.

Folder Options - Change the location of your data folder.

Message Options - Restore any messages previously displayed that have a "Do not show

again" option.

Update Options - Change the frequency of how often PFS Plus checks for updates.
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9 Help Menu

The Help menu has the following options available:

PFS Plus Help

Feedback...

Activation...

Registration...

Check for Updates

About PFS Plus

9.1 PFS Plus Help

Choosing this option displays the Help for PFS Plus. You can choose any of the items located in the
table of contents to browse or print.

9.2 Feedback...

This option will display a screen that you can fill out and submit to Pro-Ware, LLC. You can provide
feedback for enhancements that you would like to see, general questions that you would like to submit
to our technical support staff for review, or problems you may have encountered while using PFS Plus.
Clicking "Send" will email the submission form directly to Pro-Ware's support staff.

9.3 Activation...

If you are running the demo version of PFS Plus, you can choose this option once you purchase the
software. You will be able to enter the activation information that was sent to you by Pro-Ware, LLC.
Once complete, the software will stop running in the demo mode and you will be able to use beyond the
30-day limit.

9.4 Registration...

Choose this option to enter your registration information for submission to Pro-Ware. If any of your
registration information has changed, you can enter the changes here and they will be submitted to our
office so that we can update your registration in our user database. Changes may take up to 72 hours to
be posted to your account.

9.5 Check for Updates

Select this option at any time to check for updates to PFS Plus. This option can be selected at any time
and is entirely independent of the automatic update checking that PFS Plus makes according to your 
PFS Plus Options located under the Edit menu.

9.6 About PFS Plus

This screen will display information about the version and date of the PFS Plus release that you are
currently running. In addition, you can display system information by selecting the "System Information"
button.
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